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EG­KONFORMITÄTSERKLÄRUNG

Der Hersteller: Kaindl­Schleiftechnik
Reiling GmbH
Remchinger Straße 4

75203 Königsbach­Stein

erklärt hiermit, dass die nachstehend 
Universal­Schleifmaschine

beschriebene Maschine: Typ: FSM­CNC

die Sicherheits­ und Gesundheitsanforderungen EG­Maschinenrichtlinie (2006/42/EG)
folgender EG­Richtlinien erfüllt: EG­Niederspannungsrichtlinie 

(73/23/EG)
EG­Richtlinie EMV (89/336/EG)

Angewendete harmonisierte Normen:

EN ISO 12100­1 und EN ISO 12100­2;  EN ISO 13857; EN 563; 
EN 61029­1, EN 60204 Teil 1; EN 61000­6­1; EN 61000­6­2;
EN 61000­6­3; EN 61000­6­4

Konstruktive Änderungen, die Auswirkungen auf die in der Betriebsanleitung 
angegebenen technischen Daten und den bestimmungsgemäßen Gebrauch haben, die 
Maschine also wesentlich verändern, machen diese Konformitätserklärung ungültig!

Die Unterlagen wurden zusammengestellt von: Reinhard Reiling

Kaindl­Schleiftechnik
Reiling GmbH
Remchinger Straße 4
75203 Königsbach­Stein
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1. SORGFALTSPFLICHT DES BETREIBERS
Die Universal­Schleifmaschine FSM­CNC wurde unter Berücksichtigung einer 
Gefährdungsanalyse, sowie der einzuhaltenden harmonisierten Normen und weiterer 
technischer Spezifikationen konstruiert und gebaut. Sie entspricht damit dem Stand der 
Technik und gewährleistet ein Höchstmaß an Sicherheit. 

Diese Sicherheit kann in der betrieblichen Praxis jedoch nur dann erreicht werden, wenn 
alle dafür erforderlichen Maßnahmen getroffen werden. Es unterliegt der Sorgfaltspflicht 
des Betreibers der Maschine, diese Maßnahmen zu planen und ihre Ausführung zu 
kontrollieren.

Der Betreiber muss insbesondere sicherstellen, dass:

• die Maschine nur bestimmungsgemäß verwendet wird 
(vgl. Kapitel "Technische Beschreibung")

• die Maschine nur in einwandfreiem, funktionstüchtigem Zustand betrieben wird und 
besonders die Sicherheitseinrichtungen regelmäßig auf ihre Funktionstüchtigkeit 

überprüft werden
• die Betriebsanleitung stets in einem leserlichen Zustand und vollständig am 
Einsatzort der Maschine zur Verfügung steht und zur künftigen Verwendung 
aufbewahrt wird
• alle an der Maschine angebrachten Sicherheits­ und Warnhinweise nicht entfernt 
werden und leserlich bleiben
• alle Instandhaltung­ und Warnhinweise beachtet und ausgeführt werden.
• Schmiermittel kontrolliert und nachgefüllt werden. 
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2. ANFORDERUNGEN AN DAS

    BEDIENUNGSPERSONAL

Die Universal­Schleifmaschine FSM­CNC darf nur von Personen bedient werden, die mit 
den Grundlagen im Umgang einer CNC­Maschine vertraut sind und die Betriebsanleitung, 
die Programmieranleitung und die darin enthaltenen Sicherheitshinweise kennen und 
danach handeln. 
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3. TRANSPORT

4. ABMESSUNG UND GEWICHT

Die Universal­Schleifmaschine FSM­CNC wird ab Werk in einer Holzkiste geliefert. 
Das Gewicht der Maschine, einschließlich der Verpackung beträgt je nach Ausstattung
425 Kg ­ 460 Kg. 
Der Transport erfolgt mit einem Hubwagen oder Gabelstapler, unmittelbar an den 
Aufstellungsort. 

Vor der Inbetriebnahme ist die Maschine auf Transportschäden zu überprüfen!

Bitte Transportschäden bei Feststellung sofort der Spedition melden und die 
Schadensfeststellung protokollieren lassen. 

Bitte beachten: Es gelten i.A. sehr kurze Reklamationsfristen!!

Abmessungen L x B x H: 1200 x 880 x 1700 mm

Gewicht Grundausstattung ohne Steuerung: 352 Kg

Gewicht Steuerung:   37 Kg

5. UMGEBUNGSVORAUSSETZUNGEN

Die Maschine darf nur in trockenen Räumen aufgestellt werden. 
Klimavoraussetzungen: 
von +5° bis +50° Celsius, Luftfeuchtigkeit bis 90% nicht kondensierend.

Der elektrische Anschluß erfolgt über Schutzkontaktstecker CEE 7/7 (1~ 230V/50Hz; 16A)
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6. SICHERHEITSHINWEISE

Beim Umgang mit Schneid­ und Fräserwerkzeugen ist größte Vorsicht gefragt, denn 
diese können die Schärfe eines Rassiermessers besitzen. Es kann bei unvorsichtigem 
Umgang zu erheblichen Schnittverletzungen führen. 
Zum Auf­ oder Ab­ spannen eines scharfen Werkstücks, 
sind Schnittschutzhandschuhe zu tragen.

Starten Sie ein CNC­Programm nur, wenn Sie sicher sind, dass die Nullpunkte richtig 
angetastet und gespeichert wurden. Das CNC­Programm sollte vor dem ersten Start 
einem Testlauf mit ausreichend Sicherheitsabstand zur Schleifscheibe unterzogen 
werden.

Programmier­ oder Programmparameter­Fehler können erheblichen Sachschaden an der 
Maschine anrichten!

Stecken oder ziehen Sie niemals ein USB­Gerät (z. B. USB­Stick) bei laufender CNC­
Software! Das JOG­Wheel (digitales Handrad der Steuerung) könnte dadurch zerstört 
werden!

Die Schutzabdeckungen der Maschine schützen die darunter liegenden Führungen, 
Spindeln und Schalter vor Schmutz und Kühlschmierstoffe. Beim reinigen der Maschine, 
dürfen die Schutzabdeckungen weder mit Kühlschmierstoffen noch mit Reinigungsmittel 
unterspült werden!

Die Maschine ist mit einer regelbaren Schleifspindel bzw. HF­Spindel ausgesattet, 
bei Schleifkörperwechsel bitte bachten Sie die max. zulässige Schleifgeschwindigkeit des 
Schleifkörpers (m/sec.) und passen diese vor dem Einschalten der Schleifspindel an.

Eine zu hohe Drehzahl kann zum Bersten des Schleifkörpers führen und in der 
Folge zu Schäden an der Maschine oder zu erheblichen Verletzungen !!

7. BESTIMMUNGSGEMÄSSE VERWENDUNG

Die Universal­Schleifmaschine FSM­CNC ist ausschließlich zum schärfen von Fräs­ und 
diversen Schneidwerkzeugen bestimmt. Die Schleifpogramm­erstellung erfolgt nach DIN 
66025 (G­Code) bzw. durch mitgelieferte Schärfprogramme. Das Schärfen kann über die 
Elektrospindel für außenschleifen oder mittels HF­Spindel für innenschleifen erfolgen. 

Zur bestimmungsgemäßen Verwendung gehört auch das Lesen und Verstehen der 
Betriebsanleitung, sowie das Einhalten aller darin enthaltenen Hinweise. 

Für alle Sach­ und Personenschäden die aus nicht bestimmungsgmäßer Verwendung 
oder aus Programmier­ oder Programmparameter­Fehler entstehen, ist alleine der 
Betreiber verantwortlich. 
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Die Maschine ist mit den mitgelieferten Standfüße aufzustellen und anschließend mit 
einer Wasserwaage zu nivelieren. Wichtig dabei ist, das die Maschine fest und 
vibrationsfrei auf allen vier Füßen steht. Montieren Sie nun den Radsatz an das 
Steuerungsgestell und achten Sie darauf, das die Bremsrollen vorne montiert werden 
(Bedienerseite). 
Als nächstes muss die Steuerung an die Maschine angeschlossen werden. Dazu an der 
rechten Seite der Maschine die schwarze Kabelkonsole geöffnet werden. Die unteren 
beiden Schrauben (M6) mit einem 4 mm Inbusschlüssel lösen und die 
Konsolenabdeckung nach oben zu klappen. Nun können die Kabel mit den Steckern 
hindurchgeführt und der schwarze Kabelschlauch mit dem Schließen der Konsole fixiert 
werden. Mit dem montieren der unteren beiden Schrauben wird die Konsole wieder fest 
verschraubt und der Kabelschlauch ist fest montiert und zugentlastet. Nach dem Öffnen 
der Fronttür werden die Steckverbindungen hergestellt (siehe Seite 8).

8. AUFSTELLUNG DER MASCHINE UND

ANSCHLIESSEN DER STEUERUNG

Kabelkonsole

Nur diese beiden Schrauben zum öffnen der 
Kabelkonsole entfernen

Fertig montiert

Radsatz am Steuergestell. Im Anschluss 
Abdeckungen aufklippen.

Bitte beachten:
Maschine muss fest und vibrationsfrei 
am Standort aufgestellt werden!



8

Stecker Not­AusStecker Netz Steuerung Stecker für Handrad

25 Pol Sub­D Stecker mit Stifte 25 Pol Sub­D Stecker mit Buchse

HINWEIS: 

Steckverbindungen sind mechanisch kodiert und können nicht vertauscht werden!
Sub­D Stecker sind farblich und mechanisch kodiert.

Poti für Schleifspindeldrehzahl



9. ENTFERNEN DER TRANSPORTSICHERUNGEN
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Nachdem die FSM­CNC sicher auf ihren Maschinenfüßen steht und die Steuerung 
angeschlossen ist, sind die Transportsicherungen zu entfernen.

1. Entfernen Sie die beiden schwarzen Kabelbinder (Bild 2), packen Sie den 
Klemmhebel aus, stecken Sie den Klemmhebel wie auf Bild 1 auf die 
Klemmschraube und öffnen Sie die Klemmung. 
2. Mit einem Gabelschlüssel SW 13 entfernen Sie die schwarze 6­Kantschraube an 
der Transportsicherung der Achsen (Bild 2). 
3. Entfernen Sie die Fettschicht an der Z­Säule und das Ölpapier im SK 40 Konus 
der A­Achse. Danach schalten Sie die Maschine ein und starten die 

CNC­Software, um im Handbetrieb die Z­Achse nach oben zu verfahren. 

Fett­ bzw. 
Wachs­ Schicht 
entfernen!!

Haupttransportsicherung
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9.1 TRANSPORTSICHERUNGEN DER 
MASCHINENKONSOLE ENTFERNEN

1. Entfernen Sie links und rechts an der Maschinenkonsole die 2 verzinkten 
Inbusschrauben SW 8 an den signalroten Transportsicherungen.
2. Entfernen Sie die signalroten Transportsicherungen.
3. Schließen Sie die Kühlmitteleinrichtung an und befüllen Sie diese mit 
Kühlschmiermittel.

Sind alle Transportsicherungen entfernt, kann die FSM­CNC in Betrieb genommen 
werden.

Alle Teile der Transportsicherungen für zukünftige Verwendung aufbewahren !!!
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Kühlmittelablaufschlauch der FSM­CNC

3­Stufen Schalter

11. BESCHREIBUNG DER KÜHLMITTELEINRICHTUNG
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Der Kühlmittelbehälter muss 3/4 seines Volumens mit Kühlschmiermittel befüllt werden. 
Im Anschluss ist die Kühlmittelpumpe zu entlüften.

Die Kühlmitteleinrichtung wird an die blaue Steckdose der Maschine angeschlossen. Zum 
Entlüften der Pumpe, die Pumpen­Entlüftungsschraube öffnen.

Grundsätzliches zu Kühlschmierstoffen:

Bitte verwenden Sie ausschließlich wassermischbare Emulsionen auf Mineralölbasis. 
Bei synthetischen Produkten kann es zu erheblichen Schäden an der Lackierung, 
diversen Kunststoffteilen und Lagerdichtungen kommen. 

Für Schäden die von Kühlschmierstoffen entstanden sind, können wir keinerlei Haftung 
übernehmen. 

Bei der Erprobung der Kühlschmierstoffe müssen die entsprechenden Richtlinien der 
jeweiligen Schmierstoffhersteller eingehalten werden.

Bitte beachten Sie die jeweiligen Entsorgungsvorschriften für Kühlschmierstoffe.

Steckdose für 
Kühlmitteleinrichtung
1~230V/50Hz Max. 3A
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Die FSM­CNC ist mit 4 numerischen Achsen ausgestattet. 3 davon sind Linear­Achsen 
(X; Y; Z) und eine ist als Rundachse (A) definiert. Im unteren Bild sehen Sie die 
Zuordnung der Achsen. Das Richtungsmodell steht immer in Sichtweise der Schleif­
spindel (als würde sich die Schleifspindel durch den Raum bewegen).

12. ERKLÄRUNG DER NUMERISCHEN ACHSEN

Verfahrmodell in Sichtweise der Schleifspindel

HINWEIS: 
Die Achsen X; Y; und Z sind in der Maßeinheit "mm" definiert. Die A­Achse ist in "Grad" 
definiert, d. h. eine Umdrehung sind 360°, die Nachkomma­stellen sind dezimal. Die 
Vorschubsangaben sind daher "mm/min" und " °/mm".

Halter für Messtaster
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13. AUFBAU DER FSM­CNC

Kühlmittelschlauch

Klemmung Z­Achse

Kugelhahn für Kühlmittel

Arretierung A­Achse

SK 40­Aufnahme
Klemmung Winkelverstellung 

A­Achse

Schleifspindel (E­Spindel)

Aufnahmen für Kamerasystem
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14. EINRICHTEN DER HF­SPINDEL (OPTION)

Mit der Einstellschraube Inbus SW 5 wird die HF­Spindel achsenparallel zu X eingerichtet 
und mit der Kontermutter SW 10 gesichert. Erst dann wird die Spindel mit der 
Klemmschraube am Spindelhalter festgezogen. Die HF­Spindel kann in Längsrichtung 
mittels lösen der Klemmschraube am Spindelhalter verstellt werden. 

Drehzahlverstellung HF und Schleifspindel
HF­Spindel 6000 ­ 24000 U/min (weisse Skala)
Schleifspindel 10 ­ 50 m/min  (orange Skala)

Die HF­Spindel kann auch vertikal 
betrieben werden.

Einstellschrauben zum 
ausrichten der Schleifspindel

Klemmschraube SW 5 
Spindelhalter



16

15. ANSCHLÜSSE FÜR HF­SPINDEL UND A­ACHSE

Anschluss für
HF­Spindel

Anschluss für 
Referenzpunkt­
schalter

Motoranschluss
A­Achse

Hinweis:
Für alle Anschlüsse der Maschine gilt:

Stecken oder Ziehen der Anschlüsse nur bei ausgeschalteter Maschine !! 
(Netz Aus am Hauptschalter)
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16. MANUELLE VERSTELLMÖGLICHKEITEN

An der FSM­CNC gibt es einige zusätzliche, manuelle Verstellmöglichkeiten, die diese 
Maschine zu einer sehr universellen Schleifmaschine machen. Die Z­Achse lässt sich in 2 
weiteren Ebenen verstellen und so entstehen hier vielfältige Möglichkeiten, mit der 
Schleifscheibe bestimmte Werkzeuge zu bearbeiten.

16.1 HORIZONTALE VERSTELLUNG
Der gesamte Turm der Z­Achse wird dabei gedreht, nachdem die beiden Befestigungs­
schrauben geöffnet werden und mittels Ratsche die Verstellschnecke gedreht wird.

Befestigungsschrauben

Ratsche mit Nuss SW 12
an der Verstellschnecke

Winkelskala in °
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16.2 VERTIKALE WINKELVERSTELLUNG

Öffnen Sie mit der Ratsche die hintere Sechskantschraube des Spannrund. Verstellen Sie 
nun den Vertikalwinkel an der Verstellschnecke der Vertikalverstellung. Sollte dies 
anfangs nicht möglich sein, so klopfen Sie von oben leicht mit dem Ratschengriff auf die 
Schraube des Spannrund, damit diese sich lösen kann. 

Nach dem Verstellen auf den gewünschten Winkel, das Spannrund bzw. die 
Befestigungsschrauben wieder festziehen.

Ratsche mit Nuss SW 12

Sechskantschraube des Spannrund

Verstellschnecke

Winkelskala in °
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17. AUFBAU CNC­STEUERUNG
Die IPC Steuerung ist mit einem Touchscreen ausgestattet. Sie können die Buttons der 
Bedienoberfläche durch Berührung auslösen. Als Mauersatz verfügt die IPC Steuerung 
über eine Tastatur mit Touchpad. Die USB 3.0­Schnittstelle dient mittels USB­Stick zur 
zusätzlichen Datensicherung Ihrer CNC­Programme.

ACHTUNG!!!

Bei laufender CNC­Software niemals ein USB­Gerät (z. B. USB­Stick) stecken oder 
abziehen. Dies könnte das JOG­Wheel zerstören!

Touchscreen

Not­Aus 
SchlagtasterPoti SchleifspindelnUSB­AnschlussJOG­Wheel
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18. TECHNISCHE DATEN
Verfahrbereich in X: 300 mm
Verfahrbereich in Y: 135 mm
Verfahrbereich in Z: 192 mm
Schleifmotor :  3~230V/100Hz, 0.75 KW, 1330 ­ 6640 r/pm
HF­Spindel (Option): 3~230V/400Hz 0,8KW, 6000­24000 r/pm
Anschlusswert Maschine mit Steuerung: 1~230V/50­60 Hz, 1.8 KW Max.
Anzahl der numerischen Achsen: 4 (X; Y; Z; A)
Absauganschluss: vorbereitet mit Gehäusebohrung ø 100 mm
Abmessungen L x B x H: 1200 x 880 x 1700 mm
Maschinengewicht ohne Steuerung: 352 Kg
Ermittelter Schalldruckpegel: < 70 dB/A
Elektrischer Anschluß:  Kabel mit Schutzkontaktstecker 

 CEE 7/7 (1~230V/50Hz)

Steuerung: IPC Steuerung mit 15" Touchscreen
Intel i5 Prozessor ; 4 GB RAM ; 
160GB Sata Harddisk , 2x GBit LAN ; USB3.0

Betriebssystem: Ubuntu 12.04.5 LTS i386 "Precise Pangolin" 
Rtai Kernel ; Netzwerkfähig ; Fernwartungsfähig

CNC­Software: LinuxCNC Version 2.7.11
Grafische Oberfläche: Kaindl spezifisch auf TKLinuxCNC Basis

"Deus in Machina"
Gewicht Steuerung netto: 37 Kg

Kühlmittelpumpe:

Motor: 1~230V / 50 Hz
Leistung Stufe 1: 0.028 KW
Leistung Stufe 2: 0.045 KW
Leistung Stufe 3: 0.063 KW
Schutzart: IP65
Förderleistung: 16 bis 35 l/min

Technische Änderungen vorbehalten!
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19. EINSCHALTEN DER MASCHINE

Schalten Sie die Maschine rechts unten an der Konsole mit drücken des grünen Tasters 
ein. Die Maschinenbeleuchtung wird eingeschaltet und die Steuerung bootet das 
Betriebssystem hoch. 

 Hauptschalter

HINWEIS: Vor dem ausschalten der Maschine, Steuerung immer vollständig beenden!

Nach dem booten der Steuerung sehen Sie den Einschaltbildschirm. Es stehen zwei 
Maschinenkonfigurationen zur Verfügung:
1. Kaindl­FSM­Rund ist eine 3­Achs Konfiguration zum Rund­ oder Innenrund­ schleifen. 
    (A­Achse ist als Spindel konfiguriert)
2. Kaindl­FSM­CNC ist eine 4­Achs Konfiguration zum Schleifen von Fräs­ und
    Schneidwerkzeugen

HINWEIS: Jede Konfiguration hat einen eigenen unabhängigen Programmordner.
Durch Antippen des jeweiligen Bildes wird die CNC­Software LinuxCNC gestartet. 
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TK wurde von uns entsprechend an die Maschine angepasst. Nachfolgend werden nun 
die Menüs und Funktionen beschrieben. Im Menü Help ­> Help bekommen Sie auch eine 
Kurzanleitung über die Funktionen der Tastatur, den einzelnen Menüs, sowie zu den G­ 
und M­Codes. 
Nachdem die Software gestartet wurde, muss die Maschine mit der Taste F2 
eingeschaltet werden. Die Achskennzeichnung und die Darstellung der Istwerte sind 
zunächst in der Farbe gelb dargestellt, was auf die fehlende Referenz der Achsen 
hinweist. 

20. DIE GRAFISCHE BEFEHLSOBERFLÄCHE TK

Die Maschine wird durch das drücken des Buttons "Home Machine" referiert. 
Diese gibt die Meldung "homing sequenz already in progress" aus, welche mit OK quittiert 
wird. Nach dem Referenzlauf werden die Achskennzeichnung und Istwerte in der Farbe 
grün dargestellt. 

Ohne gültige Referenzpunkte ist ein Arbeiten in Automatik oder MDI nicht möglich.
 
Durch drücken des Buttons "Home Axis" wird nur die gewählte Achse referiert.

REFERIEREN DER MASCHINE

Gewählte Achse

MDI Eingabezeile

Programmabbruch 
oder Abbruch 
jeglicher Bewegung

Inkrementwahl für 
das Handrad



In den Menüs von TK finden sich viele nützliche Funktionen und Hilfsmittel, welche die 
Arbeit bzw. die Diagnose bei Fehlern sehr erleichtern. Die für Sie relevanten Funktionen 
werden hier im folgenden beschrieben:
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21. BESCHREIBUNG DER MENÜS

Menue File
File > Open Öffnet ein CNC­Programm
File > Edit  Öffnet den internen Editor zum Bearbeiten des

CNC­Programms
File > Tool Table Editor Öffnet die Werkzeugtabelle zur Ansicht bzw. zum 

Bearbeiten.
File > Reload Tool Table Laden der Wekzeugtabelle in den NC­Speicher
File > Reset Setzt das offene CNC­Programm wieder zurück

(Programm­reset)
File > Exit Beendet LinuxCNC

Menue View 
View > Offsets and Variables Öffnet die EMC.VAR zur Ansicht bzw. zum bearbeiten
View > Diagnostic  Öffnet ein Diagnosefenster (Nur für Hersteller)
View > Backplot Öffnet die Backplotansicht, welche Bewegungsabläufe im

Raum darstellt. Allerdings sind die Darstellungen nur
linear, keine Darstellung von Rundachsen.

Menue Settings
Settings > Calibration Nicht für Anwender
Settings > Debug Nicht für Anwender
Settings > Font Dient zur individuellen Einstellung der Schriftart

Menue Units
Units > auto Die Maßeinheit der Maschinenkonfiguration ist gültig
Units > inch Alle Maße in Zoll (inch)
Units > cm Alle Maße metrisch in cm
Units > mm Alle Maße metrisch in mm (Default)

Menue Utillities
Utillities > HAL­Scope Dient zur Überprüfung der Real Time Funktion
Utillities > HAL­Meter Dient zur Überprüfung diverser Signale

Menue Scripts
Scripts > Set Coordinates Öffnet ein Dialogfenster zum Setzen der NPV

(G54 ­ G59.3)
Scripts > HAL anzeigen Nicht für Anwender
Scripts > HAL­konfigurieren Nicht für Anwender



Die Funktionalität für den Programmablauf ist nahezu selbstredend.

Open ... Öffnet den Dialog zur Auswahl eines vorhandenen CNC­Programms

Run  Startet das ausgewählte CNC­Programm

Pause Stoppt das laufende CNC­Programm

Resume Startet ein gestopptes CNC­Programm

Step Das CNC­Programm wird Zeile für Zeile abgearbeitet und stoppt nach
jeder Zeile, bis mit "Fortsetzen" die nächste Zeile des Programms
gestartet wird.

Verify Überprüfen der Syntax eines geöffneten CNC­Programms

Optional Stop Mit dieser Taste wird festgelegt, ob ein Programm­Halt
mit M1 eintritt oder nicht

22. FUNKTIONEN FÜR DEN CNC­PROGRAMMABLAUF
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Hier wird ein geöffnetes CNC­Programm angezeigt!

HINWEIS:

Bei geöffneter Maschinentür oder bei zu niedrigem Schmiermittelstand 
( Zentralschmierung unterhalb von MIN ) ist ein Wechsel in eine der 
Automatikbetriebsarten (Auto oder MDI) nicht möglich!
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Das Aufspannen von Fräserwerkzeugen zum Schärfen wird bei der FSM­CNC mittels 
Standard­Werkzeugaufnahmen mit SK40 Kegel vorgenommen. Die A­Achse kann diesen 
Kegel präzise aufnehmen. Grundsätzlich kann jede SK40 Werkzeugaufnahme ohne 
Einzugszapfen (siehe Bild) eingesetzt werden, unterschiede gibt es natürlich auch in der 
Rundlaufpräzision. 
Wir empfehlen Ihnen daher, nur Werkzeugaufnahmen in guter Qualität zu benutzen. 

Bild: Standardaufnahme SK40 mit Spannzangensystem ER32

23. AUFSPANNEN VON FRÄSWERKZEUGEN

Die SK40 Aufnahme wird mit aufgespanntem Fräser von vorne in den Innenkegel der 
A­Achse eingeführt. Bitte achten Sie darauf, dass der Innenkegel wie die SK40 Aufnahme 
sauber und schmutzfrei sind. Von der hinteren Seite der A­Achse wird mit dem 
mitgelieferten Inbusschlüssel SW8 die SK40 Aufnahme festgezogen. Es ist auf die 
richtige Nasennut zu achten.

HINWEIS: 
Nach jedem Aufspannen auf die A­Achse ist eine Referenzpunktfahrt der A­Achse 
durchzuführen!

Mitnehmernase

Innengewinde M16
SK40 ohne Einzugszapfen

ER32 Spannzangensystem
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Das Festziehen der SK40 Werkzeugaufnahme erfolgt von hinten mittels Inbusschlüssel 
SW8 und zum gegenhalten wird die Arretierung gedrückt. 

HINWEIS: In der 3­Achs Konfiguration (FSM­Rund) wird die A­Achse zur Zusatzspindel und 
verfügt nicht über einen orientierten Halt am Arretierungspunkt!

Bild: A­Achse seitlich mit Arretierung und Befestigungsschraube hinten

Die A­Achse verfügt über eine zusätzliche Winkelverstellung, die es erlaubt konische 
Werkstücke ohne Interpolation zu schleifen bzw. auch dazu dienlich ist, Fräser an der 
Innenseite zu schärfen.

Winkelskala in °

Klemmung der 
Winkelverstellung

24. WINKELVERSTELLUNG AN DER A­ACHSE
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Montieren Sie den mitgelieferten mechanischen Messtaster an den Messtasterhalter am 
Schleifspindelgehäuse ( siehe Bild )
Der Messtaster lässt sich in fast jede Richtung montieren.

25. EINRICHTEN DES MESSTASTERS

Schraube (SW2,5) zum Klemmen 
des Messtasters

Schraube (SW2,5) zum Klemmen 
des Messtasterhalters.
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25.1 EINRICHTEN DER KAMERA
Montieren Sie die Kamera auf der mitgelieferten Halterung wie auf Bild1 dargestellt, und 
installieren Sie das mitgelieferte Softwarepaket auf Ihrem Notebook (nicht im Lieferumfang 
enthalten).
Die korrekte Vorgehensweise der Installation entnehmen Sie bitte dem Handbuch im 
Kamerapaket bzw. ist auf der mitgelieferten CD vorhanden.
Nach der Installation verbinden Sie die Kamera mit dem USB­Port der Maschine (Bild3) und das 
USB­Kabel der Maschine mit Ihrem Notebook.
Nach dem Start der Software, sehen Sie auf Ihrem Notebook das Livebild der Kamera.
Stellen Sie nun wie auf Bild1 sichtbar einen Anschlagwinkel im Abstand von ca.100 mm vor die 
Kamera und stellen sie das Bild scharf.
Auf der Softwareoberfläche der Kamera klicken Sie auf den        Button, um ein Fadenkreuz 
auszuwählen.
Mit dem eingeblendeten Fadenkreuz und dem Anschlagwinkel richten Sie nun durch Drehen der 
Kamera in ihrer Halterung nach dem vertikalen Strich aus (Bild2) und fixieren Sie die Kamera 
duch das festziehen der Klemmschraube (SW4) fest.
Nur festziehen, bitte nicht mit Gewallt !

Bild1

Bild3

Bild2

Klemmschraube 
(SW4)
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Das Werkstück wird im Manuellbetrieb mit dem Digital­Handrad in allen 4 (3) Achsen 
angetastet. Die Achsauswahl für das Verstellen mit dem Handrad erfolgt durch das 
Berühren der jeweiligen Achsanzeige auf dem Touchscreen. Die Achsen werden dann 
genullt mit der Funktion "Set_Coordinates" aus dem Menü "Scripts", durch drücken des 
Buttons "Teach". Drücken Sie im Anschluss daran den Button "Write" und dann "Close". 
Ihr Werkstück ist nun genullt.

Es sind folgende NPV zur festen Verwendung in den Kaindl­Programmen vorgesehen:
• G54 Werkstück NPV* für E­Spindel
• G55 Werkstück NPV* für HF­Spindel (Option) 
• G56 Schleifkörper NPV* für Anrichtvorrichtung (E­Spindel und HF­Spindel)
• G57 Messtaster NPV* für Messprogramme

G58 bis G59.3 stehen zur freien Verwendung durch den Anwender.

HINWEIS: Das digitale Handrad kann mit verschiedenen Inkrementen belegt werden und 
ist bei "Durchgehend" außer Funktion. Inkremente die zur Auswahl stehen: 0.005; 0.01; 
0.025 mm je Rastung am Handrad oder je Antippen auf die Tasten "+" oder " ­ "

*NPV = Null Punkt Verschiebung

26. ANTASTEN DES WERKSTÜCKS UND SETZEN 
DER WERKSTÜCKNULLPUNKTE 

Auswahl der NPV Inkrementauswahl hier Drücken
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Fräser werden manuell mit dem mitgelieferten mechanischen Messtaster gemessen.
Wichtig dabei ist der Winkel der Seitenschneiden, diese wird im mitgelieferten Schleifprogramm 
für Fräser #6 (Steigung der Seitenschneide in ° je mm Fräserlänge)

­ Fräser in die Aufnahme der Achse A einspannen und mittels Kamera die 
  erste Hauptschneide nach dem Fadenkreuz ausrichten.
­ Messtaster herunterklappen und an einem vorderen Punkt der Seitenschneiden mit  
  dem Messtaster im Handbetrieb antasten, Messtaster auf "Null" stellen und Anzeige 
  der A­Achtse  mit "Set Coordinates" auf null stellen.
­ 10 mm mit der X­Achse in Richtung der Aufnahme fahren und mittels Handrad die 
   A­Achse bewegen bis der Messtaster auf Null steht.
­ Auf der Anzeige der A­Achse (Bildschirm) den Winkelwert ablesen, und durch die 
       gefahrenen 10 mm teilen.

Beispiel:

In X wurde die Achse 10 mm in Richtung Aufnahme bewegt, die Achsanzeige der A­Achse zeigt 
einen wert von 39.5° an.
Der Wert 39.5° wird durch die 10 mm Dividiert und man erhält den Wert 3.95°
Dieser Wert wird im Fräserschleifprogramm un #6=3.95 eingetragen.
(Siehe Seite 32)

27. FRÄSER MESSEN

1. Messposition 2. Messposition

Hinweis:
Als Option ist auch der kabelgebundene 3D­Kantentaster KT130 erhältlich. 
Damit ist ein automatisiertes Messen möglich !!
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Im folgenden Beispiel erklären wir Ihnen, wie und an welchen Flächen ein Fräser 
angetastet werden muss, um mit unserem Standardprogramm einen Fräser zu schärfen. 
Bitte beachten Sie, dass unsere mitgelieferten Programme reine Standardfräser schärfen 
können, ohne Besonderheiten wie:
• unterschiedliche Schneidenteilung
• asynchrone Spiralwinkel
• über Mitte schneidend

Sollten Sie solche Besonderheiten benötigen, können Sie diese Programme in G­Code 
selbst erstellen. Selbstverständlich können Sie auch die vorhandenen Programme 
anpassen und diese mit sämtlichen Funktionen ausstatten, die Sie für Ihre speziellen 
Schneid­ und Fräswerkzeuge benötigen.

Die Z­Achse muss nun zur Position der A­Achsenmitte bewegt werden (das genaue Maß 
finden Sie im Messprotokoll der Maschine unter Punkt 4). 
Aus dem Menü "Scripts" wählen Sie "Set Coordinates" aus, um die Z­Achse in G54 zu 
nullen. Anschließend mit "Write" und "Close" übernehmen.
In der Betriebsart Manuell (Taste F3) schalten Sie die Schleifspindel mit der Taste F10 ein 
und tasten Sie mit dem Handrad in Achse X langsam an die ausgerichtete 
Fräserschneide an. (siehe Bild unten)

Aus dem Menü "Scripts" wählen Sie "Set Coordinates" aus um die X­Achse in G54 zu 
nullen. Anschließend mit "Write" und "Close" übernehmen. Mit dem Handrad tasten Sie 
in Y die Seitenschneide des Fräsers langsam an. (siehe Bild)
Aus dem Menü "Scripts" wählen Sie "Set Coordinates" aus um die Y­Achse in G54 zu 
nullen. Anschließend mit "Write" und "Close" übernehmen. 

Bewegen Sie den Fräser mit dem Handrad in Y einige mm von der Schleifscheibe weg 
und bewegen die A­Achse auf den Winkelwert der 2. Schneidphase. Tasten Sie dann den 
Fräser erneut in Y an und notieren Sie sich den Wert der Y­Anzeige. Dieser muss in das 
Schleifprogramm in Parameter #34 "Antastwert 2 Phase" eingetragen werden. 

Bewegen Sie nun mit dem Handrad den Fräser in Y und dann in X ca. 3­4 mm von der 
Schleifscheibe weg. Der Fräser ist nun zum Schleifen genullt. 

28. FRÄSER ANTASTEN

antasten mit 
der X­Achse

antasten mit 
der Y­Achse
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Wenn Sie keine ganz besonderen Fräser haben, können Sie die mitgelieferten Dialog 
CNC­Programme nutzen, die sehr einfach in der Bedienung sind. Es ist nur der rote 
Bereich direkt hinter dem = auszufüllen.

29. SCHLEIFEN EINES STANDARDFRÄSERS
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Das zuvor bebeschriebene CNC­Programm "Fraeser_Dia_Komplett.ngc" liegt auch in der 
geteilten Version als "Stirnseite.ngc" und "Fraeserspirale_Dia.ngc" vor. Diese ermöglichen 
einen Fräser in Teilbereichen zu schärfen, also z. B. nur die Spiralschneiden oder nur die 
Stirnschneiden. Die Variablen sind genau die selben wie bei "Fraeser_Dia_Komplett.ngc".

Sie können die Dialoge mit anderen Maßen belegen und dann unter jedem anderen 
Namen abspeichern, den Sie vergeben möchten (bis zu 256 Zeichen). Die Endung für 
CNC­Programme muss .ngc sein. 

HINWEIS: Linux unterscheidet grundsätzlich zwischen Groß­ und Kleinschreibung!

Mehr zum Thema Programmierung (DIN 66025 G­Code) finden Sie in der 
Programmieranleitung.

30. MASCHINENBEDINGTE SONDERFUNKTIONEN

(M­FUNKTION IM G­CODE)
M101 und M102 Entfallen, Umschaltung HF­Spindel erfolgt über Stecker.

M103 Einschalten Funktion für Messtastersysteme
M104 Ausschalten Funktion für Messtastersysteme 

M105 Einschalten der Sägeblatt Magnetklemmung (Option Sägeblatt schleifen)
M106 Ausschalten der Sägeblatt Magnetklemmung (Option Sägeblatt schleifen)

Die FSM­CNC ist Standardmässig mit einer regelbaren Schleifspindel ausgestattet und 
erlaubt daher eine Anpassung der Schleifgeschwindigkeit an die Schleifscheibe und das 
Werkstückmaterial. Die Einstellung erfolgt über den Poti am Steuerungstableau. 
Der Einstellbereich liegt zwischen 10 bis 50 m/sec.
Die orange Skala ist in m/sec. gerechnet auf einen Schleifkörper Ø 125 mm

Achtung!! Grundsätzlich gültig auch bei der Option HF­Spindel
Nach einem Schleifkörperwechsel, muss vor dem Einschalten der Schleifspindel, 
die max. Geschwindigkeit des Schleifkörpers überprüft und am Poti eingestellt 
werden. Besondere Vorsicht gilt bei Korrundschleifkörpern !!

Eine zu hohe Drehzahl kann zur Zerstörung des Schleifkörpers und 
in der Folge zu Maschinen oder Personenschäden führen !!!!

30.1 REGELBARE SCHLEIFSPINDEL
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31. WECHSELN DER SCHLEIFSCHEIBE
Bevor Sie die Schleifscheibe wechseln, verfahren Sie die Z­Achse ganz nach oben. 
Arretieren Sie die Schleifspindel mit dem mitgelieferten Stift Ø 6 mm und lösen Sie die 
Befestigungsschraube SW 4 im Zentrum des Schleifscheibenflansches (siehe Bild). 

Schleifscheibenbefestigungsschraube 
SW 4

Arretierstift Ø 6 mm

Abdrückschraube
M8 mit SW 6

Verwenden Sie nun die beiliegende 
Abdrückschraube M8 mit SW 6 und 
drücken Sie mit dieser die Schleif­
scheibe samt Schleifscheibenflansch 
von der Schleifspindel ab.

Setzen Sie Ihre neue Schleifscheibe 
auf die Schleifspindel und achten Sie 
darauf, das der Mitnehmerbolzen der 
Schleifscheibenaufnahme in die Nut 
der Schleifspindel gesetzt wird. 
Befestigen Sie nun die Schleifscheibe 
wieder mit der Inbusschraube im 
Zentrum und ziehen diese fest.
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32. ABRICHTEN VON KORUNDSCHLEIFKÖRPER
Auf der FSM­CNC können Sie auch Korundschleifkörper verwenden. Diese Schleifkörper 
müssen vor der Verwendung abgerichtet werden, um einen optimalen Rundlauf des 
Schleifkörpers zu erreichen und um bestmögliche Schleifergebnisse gewährleisten zu 
können. Das Abrichten der Schleifkörper erfolgt durch eine Abrichtvorrichtung auf die ein 
PKD­Abrichtdiamant montiert ist. Mit entsprechenden Abrichtprogrammen ist es möglich 
auch Formen in den Schleifkörper einzuziehen, wie z. B. Radien, Prismenformen etc. 
Im Lieferumfang haben wir ein Unterprogramm (1000.ngc) zum Umfangabrichten. Dies 
kann auch als Beispiel für eigene Abrichtprogramme dienen. Dieses Unterprogramm wird 
nach dem Abrichten entsprechend der Zustellung die NPV für Werkstück und NPV der 
Schleifscheibe in Z nachführen. Der Abrichtdiamant sollte so wie auf dem Bild eine 
Einstellung von ca. 1 mm hinter der Mitte in X liegen und in der NPV G56 die Position 
genullt werden. 

Die Schleifscheibe in Y von der Seite antasten und in NPV G56 nullen. Im Anschluss das 
selbe in der Z­Richtung und ebenfalls für Z in G56 nullen. Siehe Bilder. 
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Wie die Korundschleifkörper der E­Spindel können wir auch die Korundschleifkörper der 
Innenschleifeinrichtung (Option HF­Spindel) abrichten. Dazu muss die Abrichtvorrichtung 
montiert werden, wie auf dem Bild unten und mit "Set_Coordinates" aus dem Menü 
"Extras" die NPV G56 angetastet und abgespeichert werden.
Bitte beachten Sie auch in "Set_Coordinates" die oberste Funktion "GB" 
(grind body = Schleifkörper). Hier können Sie in den Parametern #3000 für E­Spindel 
Schleifkörper und in #3001 für HF­Spindel Schleifkörper das maximale Abrichtmaß 
eintragen, welches in den mitgelieferten Abrichtprogrammen auch überwacht wird. 

Korundschleifstift

PKD Abrichtdiamant

Abrichten: Korundschleifstift in der Innenschleifeinrichtung
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33. ELEKTRIK DER FSM

OptokopplerRelaisFrequenzumrichter
HF­Spindel (Option)

Frequenzumrichter
Schleif­Spindel 

Frequenzumrichter
Werkzeug­Spindel 
( Option )

FI­Schalter

Sekundär­Sicherung



Antriebsregler für X; Y; Z; A
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Anschlüsse zur CNC Steuerung sind 
kodiert und verwechslungssicher
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ACHTUNG:

Die FSM­CNC ist mit einem FI­Schalter ausgerüstet. Sollte dieser Schalter auslösen bzw. 
der ausgelöste FI­Schalter sich nicht mehr einschalten lassen, liegt ein ernstes 
elektrisches Problem vor. 
An der Maschine darf bis zur Behebung des elektrischen Fehlers durch eine 
Elektrofachkraft nicht mehr gearbeitet werden. 

Es kann hierbei Lebensgefahr durch einen elektrischen Schlag drohen!

Bitte den Netzstecker ziehen!

Hinweis:

Die Motorschutzschalter der Frequenzumrichter sind in den Notaus­Kreis integriert.
Das Auslösen des Schalters wird durch die Meldung "Notaus" in LinuxCNC 
angezeigt und das CNC­Programm stopt.
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34. TIPPS UND TRICKS
Da die stirnschneidenden Winkel mit dem Radius der Schleifscheibe erzeugt werden, 
wollen wir hier kurz die Mathematik dazu erläutern. 

Berechnung des Freiwinkels:

Formel zur Berechnung der Z­Höhe S/2 = r x (SIN α)

BEISPIEL:
Schleifscheiben Ø = 125 mm; Freiwinkel der Stirnschneide = 10°

125 mm/2 = r=62,5 mm; α=10°
S/2= 62,5x(SIN 10°) = 10,8530 mm

Das bedeutet, an der Fräserstirnschneide muss die Achse Z mit der Schleifscheibe 
10,8530 mm aus der Mitte nach oben fahren. 
Als nächsten Schritt müssen wir unseren Nullpunkt zur neuen Schleifscheiben­position 
nachführen. Dieser Wert wird errechnet mit der Auflösung nach h.

Berechnung der Nullpunktnachführung:

Formel zur Berechnung der X Nachführung h=S/2 x TAN(α/2)
S/2 = 10,8530 mm x TAN 5° = 0,9495 mm

Die Differenz zum Nullpunkt in X ist 0,9495 mm.

HINWEIS: Bitte beachten Sie, dass diese Formeln etwas abgeändert sind, die Sie in 
diversen Formelsammlungen finden. Das liegt daran, dass wir uns mathematisch immer 
unterhalb der Schleifscheibenmitte befinden.
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Zum betreiben verschiedener Schleifscheiben auf der Maschine ist es notwendig die richtige 
Drehzahl zu ermitteln.

Es gelten folgende Formeln:

m/sec. = Øm x Π x U/min /60 sec.

U/min. = m/sec. / (Øm x Π ) x60sec.

Beispiel:
Schleifscheibe Ø 100 mm ; Geschwindigkeit 45 m/sec.
Gesucht: Drehzahl U/min

Ø 100 mm / 1000 = 0.100 m
 45m/sec. / (Ø0.100 m x Π) = 142.85 U/sec. x 60sec. = 8571.4 U/min

Oder:

Schleifscheibe Ø 125 mm ; Drehzahl: 7300 U/min
Gesucht: m/sec.

Ø 125 mm / 1000 = 0.125 m
Ø0.125 m x Π x 7300 U/min / 60sec. = 47.778 m/sec.

Hinweis: Π = 3.1415926

Bitte beachten Sie zu diesem Thema die Seite 33 Kap. 30.1



35. ERSATZTEILLISTE
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Artikel Nr.   Bezeichnung

17717Führungssatz Y­Achse FSM­CNC:
2 x Profilschiene Y­Achse
2 x Kugelführungswagen

17718Kugelgewindespindelsatz für Y­Achse FSM­CNC:
Kugelgewindespindel Y­Achse 12x4 / 218mm komplett mit 

Kugelumlaufmutter
2 x Gewindespindellager
Schraubensicherung mittelfest 5g
Filzeinlage für Ölschmierung

17719Führungssatz X­Achse FSM­CNC:
2 x Profilschiene  X­Achse
4 x Kugelführungswagen

17720Kugelgewindespindelsatz für X­Achse FSM­CNC:
Kugelgewindespindel X­Achse 12x4 / 465mm komplett mit 

Kugelumlaufmutter
Filzeinlage für Ölschmierung
Schraubensicherung mittelfest 5g
2 x Gewindespindellager
2 x Gewindespindel­Stützlager

17740Trapez­ Gewindespindelsatz Z­Achse:
Trapezgewindespindel Z­Achse mit Bronze Mutter
Gewindespindellager für Z­Achse

17721Schleifspindel FSM­CNC (komplett)

17104Keilriemen Optibelt VB Z397 Ld/10x375 Li Z14

17723Führungsfeder Z­Achse 12x8x81 mm

17724Motorlagersatz Achsmotor 2Nm (Achsen X;Y;Z;A)

17234PU­Oelschlauch PK3 Schwarz 1m



36. SCHALTPLAN
Den Schaltplan Ihrer Maschine finden Sie im Schaltschrank auf der rechten Innenseite.
 
Sollte der Schaltplan nicht mehr vorhanden sein, wenden Sie sich bitte per E­Mail
an info@kaindl.de wir werden Ihnen einen im PDF Format zusenden.

Hinweis:

Bitte immer die Maschinenummer, und Baujahr angeben, 
damit wir Ihnen zweifelsfrei die passende Version zur Verfügung stellen können.
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36.1 ANSCHLÜSSE
Alle Steckanschlüsse innerhalb der Maschine sind in IP65 ausgeführt.
Um die Dichtheit der Steckverbindungen zu gewährleiten müssen diese handfest 
verschraubt sein.
Nicht genutzte Steckverbindungen müssen mit den mitgelieferten Abdeckungen 
verschraubt werden, damit ein eindringen von Kühlschmiermittel verhindert wird.

USB­Anschluss für Kamera

Anschluss für 3D­Taster KT130

Anschluss für Magnetklemmung
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37. ZUBEHÖR
Artikel Nr. Bezeichnung

10895 Edelkorund­Schleifscheibe Korn 60 (Grob) 125 x 20 x 20 mm 

10890 Edelkorund­Schleifscheibe Korn 80 (Mittel) 125 x 20 x 20 mm

10891 Edelkorund­Schleifscheibe Korn 180 125 x 20 x 20 mm

10893 Edelkorund­Schleifscheibe Korn 100 125 x 5 x 20 mm

11103 Edelkorund­Schleifscheibe Korn 100 125 x 10 x 20 mm

17303CBN­Topfschleifscheibe B76 ø125 mm (Standard)

17304CBN­Topfschleifscheibe B126 ø125 mm

17305Diamant­Topfschleifscheibe D76 ø125 mm (Standard)

17306Diamant­Topfschleifscheibe D126 ø125 mm

18292CBN­Topfschleifscheibe B76 ø100 mm (z.B. Zapfensenker)

18293CBN­Topfschleifscheibe B126 ø100 mm (z.B. Zapfensenker)

18294Diamant­Topfschleifscheibe D76 ø100 mm (z.B. Zapfensenker)

18295Diamant­Topfschleifscheibe D126 ø100 mm (z.B. Zapfensenker)

18296CBN­Umfangschleifscheibe B76 ø125 (Für Plan und Flachschleifen)

18297CBN­Umfangschleifscheibe B126 ø125 (Für Plan und Flachschleifen)

18298Diamant­Umfangschleifscheibe D76 ø125 (Für Plan und Flachschleifen)

18299Diamant­Umfangschleifscheibe D126 ø125 (Für Plan und Flachschleifen)

15422 Schleifscheibenaufnahme FSM für Korund­, Diamant­ und 

CBNSchleifscheiben

15856 Diamant­Abrichtscheibe D356

100 x 20 x 20 mm zum Abrichten von kunstharzgebundenen 

CBN­Schleifscheiben

15857 Siliciumcarbid­Abrichtscheibe Korn 80

100 x 30 x 20 mm zum abrichten von kunstharzgebundenen

Diamantschleifscheiben

15855 Schärfstein 100 x 40 x 15 mm zum schärfen von kunstharzgebundenen

Schleifscheiben nach dem Abrichten

16050Präzisionsspannkopf ER32 mit Inderxierung z.B. Kernbohrer

16051Präzisions­Sinus Magnettisch

17675Spannzangensatz 18 tlg. ER32; 3,0 ­ 20.0 mm ; Premium Qualität (5µ)

18305HF­Spindel und Innenschleifeinrichtung 6000 ­ 24000 U/min 0,8 KW mit

Frequenzumformer, Kabelsatz und Spannzangen ER11 (3 und 6 mm )

99999 PKD­Abrichtdiamant zum Abrichten von Korundschleifscheiben
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39. INSTANDHALTUNG
Die Werkzeugschleifmaschine FSM­CNC bedarf keiner besonderen Wartung. 
Regelmäßige Reinigung und gute Pflege begünstigen eine lange Lebensdauer der 
Maschine. 
Um die Präzision der Maschine langfristig zu gewährleisten, halten Sie sich an die 
Schmieranweisung. Verwenden Sie ausschließlich die dort benannten Ölsorten 
(Seite 46). 

Überprüfen Sie gelegentlich Netzkabel und Netzstecker auf Beschädigung, sowie das 
Kühlmittelsystem auf Dichtheit. 

Der Kühlmittlelschmierstoff ist nach den Richtlinien des Kühlmittelherstellers zu 
überprüfen.

Verwenden Sie keine aggresiven Kühlmittelschmierstoffe oder Reinigungsmittel!

40. REINIGEN DER MASCHINE
Um die volle Funktionssicherheit der Werkzeugschleifmaschine FSM­CNC auf lange Zeit 
zu gewährleisten, sollte diese regelmässig (je nach Art und Umfang des Einsatzes) 
gereinigt werden.

Schleifstaub mit Kühlmittel und Pinsel von der Maschine entfernen, hartnäckige 
Verschmutzungen mit einem handelsüblichen Maschinenreiniger säubern. 
Um Überhitzungen des Schleifmotors bzw. der Elektromotoren zu vermeiden, reinigen Sie 
bitte regelmäßig deren Kühlrippen sowie Lüfterrad + Lüftergitter. 

Keine aggresiven Reinigungsmittel verwenden !! 

Beim Reinigen der Maschine dürfen die Schutzabdeckungen weder mit 
Reinigungsmittel noch mit Kühlschmiermittel unterspült werden!

Um Korrosion zu vermeiden, Blankteile sowie brünierte Maschinenteile mit einem 
Ölfilm versehen.
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41. SCHMIEREN DER MASCHINE
Die FSM­CNC ist mit einer automatischen Zentralschmierung ausgestattet. 
Dabei sollte regelmäßig der Füllstand kontrolliert werden und ggf. mit 
Gleitbahnöl CGLP 68 (Spezifikation nach DIN 51 502) nachgefüllt werden.

Den Zentralschmiertank nicht überfüllen ( Siehe Markierung MAX. )

Wichtiger Hinweis: Minimalölstand wir von der Steuerung überwacht !!

Wird der Minimalölstand unterschritten, ist ein Wechsel von der 
Betriebsart Manuell zu Automatik bzw. MDI nicht möglich !!!

Das Gleitbahnöl CGLP 68 ist bei nahezu jedem Schmiermittelhersteller erhältlich.
 
Bei längerem Stillstand der Achsen kann die Schmierautomatik manuell abgeschaltet 
werden. Dies geschiet über den Button 

Bitte Beachten Sie, dass Sie die Schmierautamatik bei Betrieb wieder mit dem 
selben Button manuell zuschalten mussen.

Ölstand muss zwischen MIN und MAX sein.

Behälter nicht überfüllen !

Hier Gleitbahnöl CGLP68
einfüllen
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42. REPARATUR
Reparaturen an der FSM­CNC und an deren mechanischen Baugruppen dürfen nur bei 
uns im Hause Kaindl oder durch von uns ermächtigte Personen ausgeführt werden. 

Der Austausch von Verschleißteilen bleibt davon unberührt.

Der Austausch von Elektroersatzteilen darf nur durch eine Elektrofachkraft ausgeführt 
werden!

43. ENTSORGUNG DER MASCHINE

INNERHALB DER EU
Bei freier Anlieferung in unser Werk übernimmt die Firma Kaindl­Schleiftechnik Reiling 
GmbH die fachgerechte Entsorgung der Altmaschinen, nach den jeweils gültigen 
Richtlinien der Europäischen Elektro­Altgeräte Verordnung.



44. NETZWERKEINSTELLUNGEN
Die Standardeinstellung ist DHCP.
Die IP­Adresse wird bezogen von einem im Netzwerk befindlichen DHCP Server 
(meistens ein Router) der diese Funktion zur Verfügung stellt. 
Natürlich können Sie der Steuerung auch eine feste IP­Adresse zuordnen, indem Sie 
diese manuell vergeben. Die Systemeinstellungen des Betriebssystems finden Sie im 
Dashboard > Systemeinstellungen um in den unten angezeigten Bildschirm zu 
gelangen:

Über die Systemeinstellungen gelangen Sie zu den Einstellungen Netzwerk des 
Netzwerkanschlusses (Ethernet­Verbindung).
Hier können Sie dann die Einstellungen zur IP­Adresse, Gateway (Router­Adresse) etc. 
vornehmen.
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45. FERNWARTUNG

Das Bild unten zeigt die Maske zum eintragen der festen IP­Adresse in Ihrem Netzwerk.

Wenn Sie über den DHCP­Server eine feste Zuordnung der IP­Adresse wünschen, 
müssen Sie dazu die MAC­Adresse in Erfahrung bringen. Die MAC­Adresse Ihrer 
Steuerung erfahren Sie über Dashboard > Terminal". Indem Sie dort den Befehl ifconfig 
eintragen und diesen mit "Enter" bestätigen. Sie bekommen nun alle 
Nertwerkeinstellungen in Text geliefert, einschließlich der MAC­Adresse. 

Die IPC­Steuerung verfügt über die Möglichkeit der Fernwartung via Internet.
Das Betriebssystem verfügt über das Fernwartungsprogramm "Teamviewer"

HINWEIS: Eine Fernwartung kann nur in Ihrer Anwesenheit an der Maschine erfolgen 
und wird von uns telefonisch unterstützt, denn diese Verbindungsanfragen müssen von 
Ihnen auf der Steuerung manuell bestätigt werden bzw. wir benötigen von Ihnen die ID 
und das Kennwort des Teamviewers.
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46. GARANTIE
Die Garantiezeit beträgt 12 Monate ab Lieferdatum und bezieht sich auf Einschicht­
betrieb. Bei Mehrschichtbetrieb beträgt die Garantiezeit 6 Monate ab Lieferdatum unter 
der grundsätzlichen Voraussetzung eines bestimmungsgemäßen Einsatz der Maschine 
und Einhaltung der Sorgfaltspflicht des Betreibers. 

Die Garantieleistung umfasst die Kosten für den Ersatz von defekten Teilen und 
Baugruppen (dies können instandgesetzte, gebrauchte Teile und Baugruppen sein), 
einschließlich der erforderlichen Arbeitszeit.

Ausgeschlossen von jeder Garantieleistung sind: 

• betriebsbedingte Verschleißteile
• Transportschäden
• Schäden durch unsachgemäßen Einsatz der Maschine
• Schäden durch Programmierfehler oder Programm­Paramentierfehler
• Beschädigung durch Gewalteinwirkung
• Schäden und Folgeschäden die durch die Verletzung der Sorgfaltspflicht des 
Betreibers oder durch Missachtung der Sicherheitshinweise entstanden sind
• Schäden durch aggresive wie scharfe oder ätzende Reinigungsmittel, 
Lösungsmittel etc. oder aggresive Kühlschmierstoffe

Bei Garantieansprüchen bitten wir Sie, uns diese unverzüglich mitzuteilen. Wir benötigen 
dazu zwingend die Benennung von Maschinentyp, der Seriennummer und das Baujahr 
der Maschine.

Ohne Angaben des Baujahres und der Maschinennummer ist eine Bearbeitung 
Ihrer Anfrage in unserem Hause nicht möglich!

Die Rücksendung der Maschine bedarf unseres vorhergehenden Einverständnis. 
Wir behalten uns vor, die Transportkosten für nicht autorisierte Rücksendungen zu 
berechnen. 

Auf Garantie ersetzte oder ausgetauschte Teile gehen in unseren Besitz über. 
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47. OPTIONEN DER MASCHINE

47.1 SÄGEN SCHLEIFEN

In diesem Kapitel erfahren Sie alles über die erhältlichen Maschinenoptionen einschließlich der 
Beschreibung und Bedienung.

Mit der Option SSM­CNC ist es möglich auf der FSM­CNC Sägeblätter zu schleifen von ca. Ø100 
mm bis Max. Ø 450 mm.
Im Satz sind eine horizontale Rundachse, eine Magnetklemmung, 2 Sägeblattflansche sowie 
diverse Reduzierringe für die Sägeblattbohrungen, ein USB Stick mit den einer speziellen 
Maschinenkonfiguration und diversen Dialog Schleifprogramme für Sägeblätter enthalten.
Die Option "Metallsägeblätter" ist nicht enthalten, kann aber jeder Zeit nachbestellt werden um 
diese Option abrunden. (Beschreibung Seite 62)

Hinweis:
In Verbindung mit der Option HF­Spindel lassen sich Reparaturschliffe an Sägeblättern 
vornehmen bzw. ist auch das Schleifen von Hohlzähnen möglich.
Falls die Maschine mit dieser Option bestellt wurde, sind die Schleifprogramme und die dazu 
nötige Maschinenkonfiguration schon auf der Steuerung installiert.

Diese Option ist jederzeit ohne großen Aufwand nachrüstbar !
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47.1.2 EINRICHTEN SÄGEN SCHLEIFEN
Um die FSM­CNC zur Sägeblattschleifmaschine umzurüsten sind nur einige Handgriffe nötig.
1. Beenden Sie den PPC und schalten im Anschluß die Maschine aus (Hauptschalter)
2. Trennen Sie die Steckverbindungen (Seite 16) von der A­Achse 
3. Öffnen Sie die Klemmung der Winkelverstellung A­Achse und nehme Sie die A­Achse von 

der Winkelplatte ab.
4. Montieren Sie nun die horizontale Rundache auf die Winkelplatte und stellen Sie diese 
auf 0° Grad ein und schließen Sie die Klemmung der Winkelverstellung A­Achse wieder.
5. Verbinden Sie nun die Stecker der horizontalen Rundachse an 

die Steckverbindungen für die A­Achse (Seite 16)
6. Montieren Sie die Sägeblattklemmung vor die horizontale Rundachse (Bild 2) und 
schliessen sie die Magnetklemmung an der vorgesehene Steckdose (Bild 3) an.
7. Schalten Sie die Maschine wieder ein und lassen Sie den PPC booten.
8. Stecken sie den Mitgelieferten USB­Stick in den USB­Anschluß des PPC und kopieren 
Sie die darin enthaltenen Ordner KAINDL­SSM direkt in das Verzeichnis /home/cnc
9. Legen Sie eine Verknüpfung auf der Desktopoberfläche in dem Sie den Ordner 

KAINDL­SSM/language öffnen und die Befehlsverknüpfung auf den Desktop ziehen.
10. Durch das antippen der Verknüpfung auf dem Desktiop sollte nun eine neue 
Maschinenkonfiguration starten.
11. Richten Sie die Magnetklemmung nach dem Sägeblattflansch aus (Bild 1) und setzen Sie 

für Z in G54 eine NPV für das Zentrum der Schleifspindel.

Steckdose für die 
Magnetklemmung

Ausrichten der 
Magnetklemmung und 
der Schleifspindel

Bild1

Bild2

Bild3
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47.1.3 SÄGEN SCHLEIFEN
Wählen Sie zuerst den zu Ihrem Sägeblatt passenden Sägeblattaufnahmeflansch und montieren 
diesen in die Weldonaufnahme (Weldon ø30) Ihrer horizontalen Rundachse und klemmen den 
Sägeblattaufnahmeflasch mit der Klemmschraube der Weldonaufnahme.
Wählen Sie nun den passenden Reduzierring für Ihre Sägeblattbohrung im Zentrum aus.
Legen Sie Ihr Sägeblatt auf und fixieren es durch Anbringen der Deckplatte des 
Sägeblattaufnahmeflansches und ziehen Sie mittels Spannschraube handfest an.
Stecken Sie nun die Kamera in die obere Kameraaufnahme und richten Sie die Kamera so aus 
das diese direkt auf den Maschinentisch gerichtet ist (Bild)
Durch das Bewegen der Achsen X und Y im Handbetrieb mittels Handrad suchen Sie nun mit der 
Kamera das Zentrum des Sägeblattaufnahmeflansch und setzten Sie mittels "Set_Coordinates" in 
G58 NPV für die Kameraposition zur späteren Verwendung.

Bewegen Sie nun die X­Achse so weit bis Sie einen Sägezahn unter der Kamera sehen.
Mit der Software der Kamera ist es nun möglich den Zahnbrustwinkel des Sägeblattes zu 
ermitteln. Bitte beachten Sie das die horizontale Rundachse auf 0°Grad eingestellt ist.
Kennzeichnen Sie den Sägezahn den Sie gemessen haben, öffnen Sie die Klemmung der 
Winkelverstellung und stellen Sie die Horizontale Rundachse auf den gemessenen Winkelwert 
ein und schliessen Sie die Klemmung der der Winkelverstellung wieder.
Folgen Sie nun mit der Kamera (Bewegen der X und Y Achse) dem Sägezahn und überprüfen 
den Winkel erneut.
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Sollte bei wiederholtem Messen die Winkelposition nicht korrekt sein, so richten Sie den 
Sägezahn mit dem Fadenkreuz der Kamera und der Zahnbrust aus.
Nun muss der Zahnrückenwinkel gemessen werden, denn diese Angaben werden in Dialog 
Schleifprogrammen benötigt.
Öffnen Sie nun ein Schleifprogramm im Editor und füllen Sie die im Dialogbereich befindlichen 
Variablen mit den entsprechenden Werten.
Tasten Sie im Handbetrieb das Sägeblatt mit der Schleifscheibe an der Zahnbrust des 
gekennzeichneten Sägezahns an und setzen Sie unter "Set_Coordinates" G54 die NPV für die 
Achsen Y und A.
Bewegen Sie die X­Achse soweit vom Sägezahn weg, dass Sie mit der Achse Y 0.5mm in 
Richtung Zahnbrust verfahren können.
Die X­Achse bewegen Sie nun in Richtung Sägezahn bis Sie den Zahn mit der Schleifscheibe 
berühren und setzen danach mit "Set_Coordinates" die NPV G54 für die X­Achse.
Bewegen Sie die X­Achse vom Sägezahn weg. Nun können Sie Ihr Schleifprogramm im 
Automatikmodus starten.

Antasten der Zahnbrust Antasten des Zahnrücken

Winkelskala Rundachse
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47.1.4 BESONDERE MÖGLICHKEITEN
Mit der Option HF­Spindel können Sie hier sehr spezielle Möglichkeiten verwirklichen.
Sie können damit bei neu eingelöteten Sägezähnen einen Reparaturschliff durchführen oder
auch Sondersägeblätter mit Hohlzahnschliff nachschärfen, bzw. in ein Sägeblatt einschleifen.

Reparaturschliff am Zahn obere Seite Reparaturschliff am Zahn untere Seite

Hohlzahn schleifen
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47.1.5 RUNDMESSER SCHLEIFEN
Mit der horizontalen Rundachse und der 3 Achskonfiguration (FSM­Rund) lassen sich auch 
problemlos Rundmesser schleifen.
Das Komfortable dabei ist, dass die Rundmesser hier von Oben und Unten in der selben 
Aufspannung geschliffen werden können ( Abhängig von Ø Rundmesser und Schleifscheiben Ø)

Rundmesser 1. Seite schleifen.
Die Schneiden bekommen einen 
Hohlschliff der abhängig vom 
Schleifscheibenradius ist.

Rundmesser 2. Seite schleifen.
Die Schneiden bekommen einen 
Hohlschliff der abhängig vom 
Schleifscheibenradius ist.
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47.2 3D­KANTENTASTER KT130
Als neustes Zubehör der FSM­CNC bieten wir den kabelgebundenen 3D­Kantentaster KT130 an.
Mit diesem Kantentaster ist es möglich Messfunktionen automatisiert durchzuführen.
Es lassen sich Messprogramme erstellen, die z.B. Werkstücke messen, oder 
Schneidenausrichtung von Schneidwerkzeugen ermitteln, Aufspannlänge ermitteln etc.
(bzgl. Messfunktionen lesen Sie Programmieranleitung Funktion G38.x)
Die FSM­CNC ist jederzeit mit dieser Option nachrüstbar.
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Mit dem 3D­Kantentaster KT130 können Sie auch im Handbetrieb messen.
Der Kantentaster wird mit dem Befehl M103 eingeschaltet und mit dem Befehl M104 wieder 
ausgeschaltet ( siehe Seite 33 )
Um den Kantentaster KT130 im Handbetrieb zu benutzen, müssen Sie zuvor die Schutztür 
schliessen und in die Betriebsart MDI wechseln.
In die Befehlszeile schreiben Sie M103 [Enter]
Nun ist der Kantentaster KT130 eingeschaltet und sie können in die Betriebsart Manuell wechseln 
und dort den Kantentaster nutzen.
Auf dem Bildschirm können Sie mittels Tippen auf die Achsanzeigen die Achse die bewegt 
werden soll wählen und mit den Buttons "+" oder "­" in die jeweilige Richtung bewegen.
(Die sichtweise der Richtung ist immer von der Schleifscheibe aus; siehe Seite 13)
Sobald der Kantentaster berührt wird stoppt der Vorschub automatisch.
Der 3D­Kantentaster KT130 funktioniert auf allen 4 Achsen und kann diese bei Berührung auch 
stoppen. (Siehe auch Seite 22)

Hinweis:
Zum Stoppen ist immer eine Signaländerung am Kantentaster erforderlich (Berührung)
Das Selbsständige stoppen findet bei der 1. Berührung statt (Signaländerung), wenn Sie 
einen der Buttons "+" oder "­" nochmal drücken obwohl der 
Kantentaster durch Berührung gestoppt hatte, 
wird der Vorschub starten und den Kantentaster beschädigen !!!

ACHTUNG:
Werden die Achsen mit dem Handrad (Jogwheel) bewegt, wird der Vorschub grundsätzlich 
nicht gestoppt, ungeachtet der Signaländerung !!!

Steckdose für den 
3D­Kantentaster 
KT130
Nur bei ausgeschalteter 
Maschine stecken oder Ziehen!
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NOTIZEN
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BEDIENUNGSANLEITUNG
Optionales Programmpaket für Metallsägeblattschleifen 

Zahnform nach DIN1838 "B"; "BW" und "C"
 Für

FSM­CNC

Original Bedienungsanleitung
Bitte für künftige Verwendung aufbewahren!

V1.1 Ultima lima 05.2020
Kaindl­Schleiftechnik REILING GmbH, Remchinger Str. 4, D­75203 Königsbach­Stein 
Tel.: +49 7232/4001­0, Fax.: +49 7232/4001­30, Internet: www.kaindl.de, E­Mail: info@kaindl.de

62



INHALTSVERZEICHNIS
Lizenzvereinbarung          61
Produktbeschreibung         65
Zahnformen nach DIN 1838         66
Einrichten Metallsägen schleifen         67
Einrichten der Kamera         69
Metallsägen schleifen         71
Neu Einzahnen einer Metallsäge         73
Wichtige Hinweise         74
Notizen .... ab         75

63



64

Software Lizenzvertrag für Kaindl ­CNC­Schleifprogramme

Mit der Lieferung der Universalschleifmaschine FSM­CNC mit den Installierten CNC­Schleifprogramme bzw. ab der 
Installation der CNC­Schleifprogramme (im Nachkauf), geben Sie Ihr Einverständnis zu diesem Software Nutzungs­
Lizenz­Vertrag

Durch Ihr Einverständnis wird ein rechtsverbindlicher Vertrag zwischen Ihnen als Endnutzer der Software (im 
folgenden "Anwender") sowie Kaindl­Schleiftechnik 
REILING GMBH geschlossen.

Mit der Zustimmung dieses Vertrages, erteilt Kaindl­Schleiftechnik REILING GMBH Ihnen eine nicht ausschließliche 
Lizenz für den Gebrauch der Installierten  Software (im folgenden "CNC­Schleifprogramme") auf der Steuerung der 
FSM­CNC.

1. Eigentumsrecht

Bei den CNC­Programmen handelt es sich um urheberrechtlich geschütztes Material. Durch diesen Vertrag werden 
Sie nicht Eigentümer der CNC­Schleifprogramme, sind aber zum Gebrauch der CNC­Schleifprogramme nach 
Maßgabe der Bestimmungen dieses Vertrages berechtigt. Weitergehende Rechte werden nicht erworben.

2. Nutzungsumfang 

Kaindl­Schleiftechnik REILING GmbH räumt Ihnen durch diese Lizenz das Recht ein, die CNC­Programme auf einer 
Steuerung zu benutzen, die in Verbindung mit der Universalschleifmaschine FSM­CNC steht. Benutzen bedeutet 
dabei jeder dauerhaft oder vorübergehende Einsatz der CNC­Programme durch Speichern, Laden, Ablaufen oder 
Anzeigen zum Zwecke der Ausführung des Programms sowie die Verarbeitung von im Programm enthaltenen Daten. 
Der Einsatz auf anderer Hardware bedarf des Abschlusses eines weiteren Lizenzvertrages.

3. Vervielfältigungsrechte

(1) Der Anwender darf die CNC­Programme nur vervielfältigen, soweit dies zur Nutzung notwendig ist. Hierzu zählt 
die Installation sowie das Laden in den Arbeitsspeicher.

(2) Der Anwender ist berechtigt, eine weitere Sicherungskopie anzufertigen und aufzubewahren, sofern sie zur 
Sicherung künftiger Benutzung erforderlich ist. Diese ist als solche des überlassenen Programms zu kennzeichnen.

Wer aus Gründen der Datensicherheit oder der Sicherstellung einer schnellen Reaktivierung des Computersystems 
nach einem Totalausfall die turnusmäßige Sicherung des gesamten Datenbestandes einschließlich der eingesetzten 
CNC­Schleifprogramme vornimmt, dürfen Sicherungskopien in der zwingend erforderlichen Anzahl hergestellt 
werden. 
Diese dürfen nur zu archivarischen Zwecken benutzt werden.

(3) Weitere Kopien der Programme darf der Anwender nicht vornehmen. Kopien der Dokumentation dürfen nicht 
angefertigt werden.

(4) Unzulässig ist die Dekompilierung, sofern diese nicht durch gesetzliche Vorschriften ausdrücklich erlaubt ist.

Im Programm enthaltene Firmennamen, Seriennummern und andere der Programmidentifikation dienende Merkmale 
sowie sonstige Vermerke über Rechtsvorbehalte dürfen nicht geändert werden.
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4. Weitergabe

(1) Dieser Vertrag endet automatisch mit der Weitergabe der Programme, bzw. der Universalschleifmaschine FSM­
CNC an einen Dritten im Verhältnis zum Anwender. Der Dritte tritt an die Stelle des Anwenders.

(2) Die Weitergabe der CNC­Schleifprogramme darf nur erfolgen, wenn sich der Dritte mit der Geltung der in diesem 
Vertrag festgelegten Bestimmungen ihm gegenüber einverstanden erklärt. Der Anwender hat dem Dritten diese 
Bestimmungen zur Kenntnis zu bringen. Ist er nicht im Besitz dieses Vertragstextes, kann er auf seine Kosten einen 
neuen von 
Kaindl­Schleiftechnik REILING GMBH erhalten.

(3) Mit der Abgabe hat der Anwender alle Kopien und Teilkopien sowie geänderte oder bearbeitete Fassung und 
davon hergestellte Kopien und Teilkopien unverzüglich zu löschen oder sonst zu vernichten. Dies gilt auch für 
Sicherungskopien.

(4) Der Anwender hat nicht das Recht, die ihm durch diesen Vertrag gewährten Rechte aufzuteilen, zu vermieten, zu 
verleasen oder auf sonstige Weise zu übertragen oder Unterlizenzen zu erteilen, sofern ihm dies nicht durch diesen 
Vertrag erlaubt ist.

5. Gewährleistung

(1) Kaindl­Schleiftechnik REILING GMBH haftet nur für Kaindl­Original Programme.

(2) Eine Herstellung von Software, die bei allen Anwendungsbedingungen fehlerfrei arbeitet, ist nach dem Stand der 
Technik nicht möglich. Kaindl­Schleiftechnik REILING GMBH hat alles notwendige getan, daß die Software und die 
Dokumentation zum Zeitpunkt der Auslieferung fehlerfrei ist und die erforderlichen Fähigkeiten aufweist. Sollten 
dennoch Mängel auftreten, so wird Kaindl­Schleiftechnik REILING GMBH den Mangel innerhalb einer 
Gewährleistungsfrist von 3 Monaten beheben. Kaindl­Schleiftechnik REILING GMBH hat die Wahl zwischen 
kostenfreier Nachbesserung oder Ersatzlieferung.

(3) Die Gewährleistungsfrist beginnt mit der Auslieferung der Programme bzw. der Universalschleifmaschine FSM­
CNC auf deren Steuerung die Programme installiert sind.

(4) Ist eine Behebung innerhalb angemessener Frist nicht möglich oder ist die Nachbesserung oder Ersatzlieferung 
als fehlgeschlagen anzusehen, so kann der Anwender die Herabsetzung der Vergütung (Minderung) oder die 
Rückgängigmachung des Vertrages (Wandlung) verlangen. Von einem Fehlschlag kann nur ausgegangen werden, 
wenn Kaindl­Schleiftechnik REILING GMBH hinreichende Gelegenheit zur Behebung des Fehlers hatte, ihr dies 
unmöglich ist oder eine Unzumutbarkeit aus sonstigen Gründen vorliegt.

(5) Die Gewährleistung ist ausgeschlossen, wenn ein Mißbrauch, eine falsche Verwendung oder die Verwendung in 
fehlerhaften Anlagen oder fehlerhaften Parametern erfolgt ist.

(6) Eine Fehlerbehebung durch Dritte ist ausgeschlossen. In diesem Fall ist 
Kaindl­Schleiftechnik REILING GMBH berechtigt, nach seiner Wahl vom Vertrag zurückzutreten oder eine Version 
der neuesten Programmversion bereitzustellen. Eine Verlängerung der Gewährleistungsfrist tritt dadurch nicht ein.

(7) Für Übermittlungsfehler während eines Downloads, oder einer anderen Übertragungsart haftet Kaindl­
Schleiftechnik REILING GMBH nicht.
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6. Haftungsbeschränkung

(1) Kaindl­Schleiftechnik REILING GMBH haftet nur für Vorsatz und grobe Fahrlässigkeit sowie für das Fehlen 
zugesicherter Eigenschaften. Im übrigen erfolgt die Verwendung der Software auf das Risiko des Anwenders.

(2) Kaindl­Schleiftechnik REILING GMBH haftet bis zu einem Höchstbetrag in Höhe des Überlassungsentgelts.

(3) Darüber hinaus wird die Haftung für Datenverlust auf den typischen
Wiederherstellungsaufwand beschränkt, der bei regelmäßiger und gefahrentsprechender Anfertigung von 
Sicherungskopien eingetreten wäre, jedoch höchstens bis zur unter 6 (2) genannten Grenze.

(4) Die Haftung nach dem Produkthaftungsgesetz bleibt unberührt.

7. Haftungsausschluß 

Kaindl­Schleiftechnik REILING GMBH haftet nicht für unmittelbare oder mittelbare Folgeschäden, für entgangenen 
Gewinn oder einen schaden, der auf fehlender Einsatzfähigkeit der Software beruht, auch wenn Kaindl­Schleiftechnik 
REILING GMBH über einen solchen Schaden unterrichtet wurde. Dieser Ausschluß bezieht sich auf Schäden an 
Rechtsgütern aller Art.

8. Untersuchungs­ und Rügepflicht

(1) Der Anwender ist verpflichtet, die CNC­Schleifprogramme auf erkennbare Mängel zu untersuchen. Dies sind 
offensichtliche Mängel, die einem durchschnittlichen Kunden ohne weiteres auffallen. Diese müssen innerhalb von 
vierzehn Tagen nach Übermittlung oder Auslieferung der Software bzw. der Universalschleifmaschine FSM­CNC 
gerügt werden, sonst entfällt eine Gewährleistungspflicht von Kaindl­Schleiftechnik REILING GMBH.

(2) Verstecke Mängel sind innerhalb von zwei Wochen nach dem Erkennen zu rügen.

(3) Weitergehende Pflichten des Anwenders im kaufmännischen Verkehr bleiben unberührt.

(4) Bei Verletzung dieser Pflicht gilt die Software als genehmigt.

9. Ausschließlichkeit, Schriftform

(1) In diesem Vertrag ist das Rechtsverhältnis zwischen dem Anwender und Kaindl­Schleiftechnik REILING GMBH in 
bezug auf die vertraglich geschuldeten Leistungen umfassend geregelt. Weitere Nebenabsprachen bestehen nicht. 
Eventuell früher bestehende Absprachen oder Vereinbarungen sind hierdurch aufgehoben worden.

(2) Eine Änderung dieser Lizenz ist nur schriftlich möglich. Eine Änderung des Schriftformerfordernisses selbst bedarf 
ebenfalls der Schriftform.

10. Geheimhaltung

(1) Der Anwender verpflichtet sich, nach besten Kräften alle zumutbaren Maßnahmen zu treffen, um zu verhindern, 
daß Unbefugte Zugang zu den CNC­Schleifprogramme oder Dokumentation erlangen, daß keine unberechtigte 
Kopie oder sonstige ­ auch nur teilweise ! Offenlegung des Vertragsgegenstandes erfolgt.

(2) Für jede im Zusammenhang mit der Durchführung dieses Vertrages erlangten Information, die für die Entwicklung, 
Herstellung oder Vermarktung eines Programms oder sonst für eine das Urheberrecht verletzende Handlung 
verwendet werden kann, gilt Vertraulichkeit als vereinbart.
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11. Allgemeines

(1) (Salvatorische Klausel) Sollten eine oder mehrere Bestimmungen dieses Lizenzvertrages, gleich aus welchem 
Grunde, ganz oder teilweise unwirksam sein, so wird hierdurch die Gültigkeit der übrigen Bestimmungen dieses 
Vertrages nicht berührt.

(2) Sämtliche Mitteilungen an Kaindl­Schleiftechnik REILING GMBH müssen schriftlich an die folgende Adresse 
gesendet werden: 

Kaindl­Schleiftechnik
REILING GMBH
Remchinger Strasse 4
75203 Königsbach­Stein

(3) Auf diesen Vertrag findet das Recht der Bundesrepublik Deutschland Anwendung.

(4) Ist der Anwender Vollkaufmann im Sinne des Handelsgesetzbuches juristische Person des öffentlichen Rechts 
oder öffentlich­rechtliches Sondervermögen, ist Pforzheim ausschließlicher Gerichtsstand für alle sich aus dem 
Vertragsverhältnis unmittelbar oder mittelbar ergebenden Streitigkeiten.
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Die CNC­Programme "Metallsägeblätter schleifen" dienen einzig dazu mit der 
Universalschleifmaschine FSM­CNC in der Verbindung mit der Option "Sägeblätter schleifen",
Metallkreissägeblätter mit den Teilungen von T3 bis T18 zu schleifen, mit der Zahnform nach 
DIN 1838 "B", "BW" und "C".

Der Durchmesserbereich beginnt bei Ø 125 und reicht bis zu Ø 315 mm.

Zum Schleifen der Zahnformen T5 bis T18 benötigen Sie:
 
für den Ø größer 150 mm:
Schleifscheibe Art.Nr.18784 (Ø125 mm, R1.0 B151)
für Zahnformen T3 bis T5:
Schleifscheibe Art.Nr. 19568 (Ø125 mm, R0.5 B151)

für den Ø kleiner 150 mm:
Schleifscheibe Art.Nr.18783 (Ø75 mm, R1.0 B151)
für Zahnformen T3 bis T5:
Schleifscheibe Art.Nr.19446 (Ø75 mm, R0.5 B151)

Die CNC­Schleifprogramme sind als Universalprogramme zu verstehen, diese schleifen die 
Metallsägeblätter mit universal einsetzbarer Zahngeometrie (Spanwinkel von 10° bis ca. 18° und 
Freiwinkel ca 10°).

Die Zahngeometrie eignet zum Sägen der meisten Stähle ( bis 1200N/mm² ) Grauguss, 
Aluminium, Messing und Kupfer etc.

Die Teilungen ergeben sich aus Durchmesser und Zähnezahl.

Beispiel:
Sägeblatt Ø315 Z54

315 x Π=989.60 mm
989.60/Z54=18,325 mm

Demnach ergibt sich eine Teilung von T18 (Tolerranzbereich 17,7 bis 18,35)

Bitte beachten Sie, dass unser Programmpaket nur mit den Orginal Kaindl­
Schleifscheiben die besten Resultate liefert und auch nur so die korrekte 
Zahngeometrie gewährleistet wird.

Die CNC­Schleifprogramme prüfen Ihre Eingaben im Dialogbereich nicht auf 
Schlüssigkeit. Bitte vergewissern Sie sich auf die Richtigkeit Ihrer Eingabewerte

Hinweis: In Kürze wird auch eine pneumatische Sägeblattspannung optional 
verfügbar sein, mit dieser können Sie in Verbindung mit 

Diamantschleifscheiben auch Vollhartmetall 

PRODUKTBESCHREIBUNG
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ZAHFORMEN

Die Zahnformen der DIN 1838 unterscheidet 3 verschiedene Formen des Bogenzahns:

Die Zahnform "B" ist die Grundform des Bogenzahns.
Alle Zähne sind gleich hoch und haben keine Phasen am Zahnrücken.

Die Zahnform "BW" stellt dabei nur eine Erweiterung von der Zahnform "B" dar, in dem 
abwechselnd jeder Zahnrücken mal rechts und links mit 45° zu 1/3 der Sägeblattbreite gephast 
ist. (Siehe Bild Zahnform BW)

Die Zahnform "C" beinhaltet die Grundform der Zahnform "B", unterscheidet sich aber in 2 
Dingen:
1. Jeder 2. Zahn ist ein Trapezzahn (links und rechts mit 45°, zu je 1/3
     der Sägeblattbreite gephast ist)

2. Jeder Trapezzahn hat einen Höhenunterschied, der je nach Teiling "T" unterschiedlich ist.

Teilung T3 bis T10 liewgt der Höhenunterschied zwischn 0.15 und 0.20 mm, 
bei den Teilungen T12 bis T18 liegt der Hölhenunterschied zwischen 0.20 und 0.30 mm.
In der Schleifprogrammen haben Sie die freie Wahl es nach Ihren Bedürfnissen anzupassen.
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EINRICHTEN METALLSÄGEN SCHLEIFEN
Um die FSM­CNC zur Sägeblattschleifmaschine umzurüsten sind nur einige Handgriffe nötig.
1. Beenden Sie den PPC und schalten im Anschluß die Maschine aus (Hauptschalter)
2. Trennen Sie die Steckverbindungen (Bedienungsanleitung Seite 16) von der A­Achse 
3. Öffnen Sie die Klemmung der Winkelverstellung A­Achse und nehme Sie die A­Achse von 

der Winkelplatte ab.
4. Montieren Sie nun die horizontale Rundache auf die Winkelplatte und stellen Sie diese 
auf 0° Grad ein und schließen Sie die Klemmung der Winkelverstellung A­Achse wieder.
5. Verbinden Sie nun die Stecker der horizontalen Rundachse an 

die Steckverbindungen für die A­Achse (Bedienungsanleitung Seite 16)
6. Öffnen Sie die Befestigungsschrauben der Winkelplatte und schieben Sie die Winkelplatte 

mit der Horizontalachse nach vorne. Bitte Maß von 120 mm beachten (Seite10 Bild1)
7. Montieren Sie die Sägeblattklemmung vor die horizontale Rundachse (Bild 2) und 
schliessen sie die Magnetklemmung an der vorgesehene Steckdose (Bild 3) an.
8. Schalten Sie die Maschine wieder ein und lassen Sie den PPC booten.
9. Stecken sie den Mitgelieferten USB­Stick in den USB­Anschluß des PPC und kopieren 
Sie die darin enthaltenen Ordner HSS­Saege direkt in das Verzeichnis /home/cnc/KAINDL­
SSM/nc­files/

10. Richten Sie die Magnetklemmung nach dem Sägeblattflansch aus (Bild 1) und setzen Sie 
für Z in G54 eine NPV für das Zentrum der Schleifspindel.

Steckdose für die 
Magnetklemmung

Ausrichten der 
Magnetklemmung und 
der Schleifspindel

Bild1

Bild2

Bild3
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Nun müssen noch einige kleine Einstellungen vorgenommen werden, um den Bogenzahn richtig 
zu schleifen.
Ein besondere Beachtung liegt auch in der Position der Horizontalachse 
(siehe Bild1 und Seite 9 Punkt 6.)

Montieren Sie nun die Schleifscheibe Art.Nr.18784 auf die Schleifspindel für Sägen Ø kleiner 150 
mm oder die Schleifscheibe Art.Nr.18783 für Sägen Ø größer 150 mm.

Drehen Sie nun den Turm der Z­Achse um 1° weiter im Uhrzeigersinn als Sie Spanwinkel 
schleifen möchten.
Beispiel: Spanwinkel 10° Turm drehen auf 11° oder Spanwinkel 15°, Turmwinkel auf 16° etc.
(siehe Bild2 und auch Bedienungsanleitung Seite 17 Kap.16.1)

Bild1

11° für T3 bis T18

Bild2
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Nun muss die Kamera neu ausgerichtet werden, denn die Striche des Fadenkreuzes sind nun um 
11° verdreht. Gehen Sie nun wie folgt vor:

1. Bewegen Sie die X­Achse im Handbetrieb mittels Jogwheel in die ­ Richtung zu einem 
freien Platz auf dem Maschinentisch.

2. Legen Sie ein Blatt Papier o.ä. auf den Maschinentisch, und einen Anschlagwinkel
auf das Papier und legen den Anschlagwinkel am Maschinentisch an (Bild1)

3. Bewegen Sie nun die Achsen X und Y so das die Kamera die Kante des Anschlagwinkels
erfasst, zum "Scharf" stellen bewegen Sie die Z­Achse.

4. Öffnen Sie die Klemmung der Kamera (Rundklemmung) etwas und justieren das
das Fadenkreuz an der Kante des Anschlagwinkels (Bild Seite 12)

5. Schließen Sie die Klemmung der Kamera und überprüfen die Richtigkeit Ihrer Einstellung.

Nun ist die Kamera Einsatzbereit zum Ausrichten Ihrer Metallsägeblätter!

Lesen Sie dazu auch die Bedienungsanleitung Seite 28 Kap. 25.1 der FSM­CNC

EINRICHTEN DER KAMERA

Bild1
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So wie auf dem Bild unten, sieht eine korrekt justierte Kamera aus
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METALLSÄGEN SCHLEIFEN
Wählen Sie zuerst den zu Ihrem Sägeblatt passenden Sägeblattaufnahmeflansch und montieren 
diesen in die Weldonaufnahme (Weldon ø30) Ihrer horizontalen Rundachse und klemmen den 
Sägeblattaufnahmeflasch mit der Klemmschraube der Weldonaufnahme.
Wählen Sie nun den passenden Reduzierring für Ihre Sägeblattbohrung im Zentrum aus.
Legen Sie Ihr Sägeblatt auf und fixieren es durch Anbringen der Deckplatte des 
Sägeblattaufnahmeflansches und ziehen Sie mittels Spannschraube handfest an.
Stecken Sie nun die Kamera in die obere Kameraaufnahme und richten Sie die Kamera so aus 
das diese direkt auf den Maschinentisch gerichtet ist (Bild)
Durch das Bewegen der Achsen X und Y im Handbetrieb mittels Handrad suchen Sie nun mit der 
Kamera das Zentrum des Sägeblattaufnahmeflansch und setzten Sie mittels "Set_Coordinates" in 
G56 NPV für die Kameraposition zur späteren Verwendung.

Bewegen Sie nun die X­Achse so weit bis Sie einen Sägezahn unter der Kamera sehen.
Mit dem Jogwheel drehen Sie nun die A­Achse bis sie den Sägezahn so sehen wie auf dem Bild 
unten links. Bei den Zahnformen "BW" und "C" ist die Zahnphase 45° in der Kamera zu sehen.
Bitte beachten Sie das die horizontale Rundachse auf 0°Grad eingestellt ist.
Kennzeichnen Sie diesen Sägezahn und positionieren Sie diesen um die halbe Teilung in 
A ­Richtung (Siehe Bild unten rechts).
Die halbe Teilung (T/2) ist notwendig, um den Sägezahn auf einer durchmesserneutralen Position 
zu schleifen.
Setzen Sie mittels "Set_Coordinates" in G54 A­Achse den Nullpunkt.
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Die halbe Teilung errechnet sich mit folgender Formel:
T/2=360°/(Zähnezahl x 2)
Beispiel: 

Sägeblatt Ø315 Z54
T/2=360°/(Z54 x 2)=360°/108=3,333333°
T/2=3.333333°

Öffnen Sie nun ein CNC­Schleifprogramm (Auswahl nach Zahnform "B" ; "BW" ; "C" und 
Teilung "T") im Editor und füllen Sie die im Dialogbereich befindlichen Variablen mit den 
entsprechenden Werten.
Tasten Sie im Handbetrieb das Sägeblatt mit der Schleifscheibe an der Zahnbrust des 
gekennzeichneten Sägezahns an und setzen Sie unter "Set_Coordinates" G54 die NPV für die 
Achse Y .
Im Anschluß daran tasten Sie im Handbetrieb das Sägeblatt mit der Schleifscheibe am 
Zahnrücken des gekennzeichneten Sägezahns an und setzen Sie unter "Set_Coordinates" G54 
die NPV für die Achse X .
Bewegen Sie die X­Achse ca. 10mm vom Sägezahn weg ( in Minus Richtung). 
Nun können Sie Ihr Schleifprogramm im Automatikmodus starten.

Antastposition mit der 
Schleifscheibe am 
Zahnrücken.

Antastposition mit der 
Schleifscheibe an der 
Zahnbrust
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NEU EINZAHNEN EINER METALLSÄGE
Um ein Metallsägeblatt neu Einzahnen zu können, müssen zuvor die "alten" Sägezähne 
weggeschliffen werden.

Dies realisieren Sie am besten mit der Maschinenkonfiguration Kaindl­FSM­RMS.
Diese Maschinenkonfiguration ist ein Bestandteil der Option "Sägeblätter schleifen"
Im Grunde wird die alte Verzahnung einfach weggeschliffen als würden Sie ein "Rundmesser" 
schleifen, der einzige unterschied ist, das Sie die Verzahnung "Stumpf" weg schleifen.

Zur neu Einzahnung gehen Sie vor, wie oben beschrieben "Metallsägen schleifen", der einzige 
Unterschied liegt darin, das Sie zur Orientierung keinen Sägezahn haben.

* Machen Sie dazu mit einem dünnen Farbstift eine kleine Markierung auf Ihr Sägeblattrohling.

* Nun richten Sie die Markierung aus wie einen Sägezahn (Seite 13)

* Ihre Antastpositionen mit der Schleifscheibe ist bei der Markierung am Ø für den Zahnrücken
  und etwas vor der Markierung für die Zahnbrust.

* Setzen Sie ensprechend dieser Positionen Ihren Nullpunkt in G54 genau wie auf den 
  Seiten 13 und 14 beschrieben.

* Öffnen Sie dazu das Programm je nach Teilung die Sie wünschen T...­Neu.ngc

* Machen Sie im Dialog Feld Ihre Werteingaben je nach dem was Sie wünschen.

Bitte beachten ! 
Die Programme prüfen Ihre Eingaben nicht nach Schlüssigkeit!!!

Nun können Sie das von Ihnen gewählte CNC.Programm starten

Bitte beachten !
Es wird nur eine Grundverzahnung eingeschliffen, 

der Endschliff erfolgt über die Nachschleifprogramme für die entsprechenden 
Zahnformen "B" ; "BW" und "C"
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WICHTIGE HINWEISE

* Technische Änderungen dienen dem Fortschritt und sind grundsätzlich unter 
Vorbehalt !

* Der Einsatz der CNC­Programme findet grundsätzlich unter der alleinigen 
Verantwortung des Maschinenbetreibes statt !

* Die CNC­Programme prüfen Ihre Eingaben in den Dialogfeldern nicht auf 
Schlüssigkeit, diese Prüfung liegt in der Verantwortung des Benutzers !

* Beachten Sie unbedingt die Bedienunsanleitung der FSM­CNC und alle der darin 
enthaltenen Hinweise und Sícherheitshinweise, u.a. auch die 

"Anforderungen an das Bedienpersonal" !!

* Zu hohe Vorschubgeschwindigkeiten und (bzw.) zu tiefe Zustellungen können
zur Beschädigung der Schleifscheibe, des Werkstücks oder gar zu 

Beschädigungen an der Maschine selbst führen !!

* Falsche und (bzw.) unschlüssige Parametereingaben in den Dialogfeldern können 
zum "Crash" führen, bitte prüfen Sie Ihre Eingaben, 

bevor Sie ein Programm starten !!

* Bei Ihnen unbekannten Metallsägeblättern ist Vorsicht geboten !!
Die Ausformung der Bogenzähne ist mit sehr großer Wahrscheinlichkeit 
unterschiedlich. Bitte mit kleinen Vorschubwerten den Erstschliff durchführen !!!

* Verwenden Sie ausschließlich orginal Kaindl­Schleifscheiben, nur diese 
gewährleisten auch optimale Ergebnisse !!!

Art.Nr.18784 (Ø125, B151, R1.0)
Art.Nr.18783 (Ø75, B151, R1.0)
Art.Nr.19568 (Ø125, B151, R0.5  (Für kleiner T5))
Art.Nr.19446 (Ø75, B151, R0.5  (Für kleiner T5))
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NOTIZEN
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NOTIZEN


